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改訂履歴
記述日 バージョン 備考

2025/10/10 Version1.0 New release.

2025/10/30 Version1.1 API用の軌道表示ツール(キネマティクスビューア)のパラメータ使用方法を追加

2025/11/17 Version1.2

• 用語を変更: “マスタ/スレーブ” → “Mデバイス / Subデバイス”

• タイプミスの修正 スライド59 (“down” → “done”)

• 86Duino IDE 501+ 紹介の追加 スライド5
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1.プロジェクト紹介
部品表と要件



プロジェクト紹介

OVR6048K1-Vのための完全な開発フローを、QEC-M-
090T（EtherCAT MDevice + HMI）と6台のAZD-KREDドラ
イバを用いて構築しました。 このシステムは、DC同期によ
るECAT_SYNCで動作し、 配線と初期パラメータテンプ

レート、原点復帰と安全機能、関節空間での初心者向け運
動解析テスト、そして作業空間での「球状周回」デモを網
羅しています。

また、86HMIに結び付けられたArduBlockブロックという
ローコードパスも提供しているため、ユーザーは 86Duinoで
モーションのプロトタイプ作成、PDO の監視、結果の検証を迅
速に行うことができます。

運動学ビューア

86Duino 86HMI ArduBlock 4
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ソフトウエア : 86Duino IDE 501+
86Duino IDE（統合開発環境）は、コードの記述と86Duinoボードへのアップロードを簡単にします。

Windows、Mac OS X、およびLinux上で動作し、環境は Javaで書かれており、Arduino IDE、Processing、

DJGPP、その他のオープンソースソフトウェアをベースにしています。

86duino最新版のアップデート内容

新メジャーリリースの86Duino IDE 501+ は、より高速でより強力になりました。サードパーティ製

EtherCAT サブデバイスへの対応範囲が拡大され、追加の EthercatDevice クラスが導入されました。これ

にはCiA-402 規格に準拠するあらゆる EtherCAT サーボドライブを制御するために設計された汎用 CiA-
402 サブデバイスクラスも含まれます。

86Duino IDE 501+

86Duino IDE 501+ Logo

* 備考: Oriental Motor 6-axis OVR6048K1-V arm 向けには特別な86Duino IDEビルドを提供します（モデルヘルパーとサンプルを含みます）

QEC.TW website



OVR6048K1-V

QEC-M-090T

AZD-KRED

部品表と要件
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ハードウェア

• EtherCAT Mデバイス : QEC-M-090T
• EtherCAT ドライブ : AZD-KRED x6
• ロボットアーム & メカニクス : OVR6048K1-V (モーターは下記の通り)

― S:   M1:  DGB130R36-AZAKL
― L:   M2:  AZM66MKH + CSG-20-100-2UH-LW-SP-B
― U:   M3:  AZM66MKH + CSG-20-100-2UH-LW-SP-B
― R:   M4:  AZM26AK + CSF-8-50-2UP-SP-A
― Bp: M5:  AZM24AK + CSF-8-50-2UP-SP-A
― T:   M6:  AZM24AK + CSF-8-50-2UP-SP-A

Software

• 86Duino IDE 501プレビュー
(オリエンタルモーター社ロボット・アーム・バージョン)



AZD-KRED

OVR6048K1-V
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Subデバイス 
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MDevice
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Subデバイス 
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AZD-KRED
Subデバイス 
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AZD-KRED

Subデバイス 3

AZD-KRED

Subデバイス 4

AZD-KRED

Subデバイス 5

配線図

* 位置に基づくアドレス指定（ケーブルの順序によって固定）、スワップしないでください。

IN
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ノード順序

• S:   M1: SubDevice 5
• L:   M2: SubDevice 4
• U:   M3: SubDevice 3 
• R:   M4: SubDevice 2
• Bp: M5: SubDevice 1
• T:   M6: SubDevice 0



Mデバイス概要｜QEC-M-090T
• QEC-M-090Tの仕様、配線、機能、安全性については、必ず当社の公式マニュアルに従ってください:

https://www.qec.tw/product/qec-m-090t/

• このプロジェクトでは、QEC-M-090T(EtherCAT Mデバイス・オープン・フレーム、9インチ LCD) を使用します。

• 製品の特長:
• リアルタイムデュアルコアCPU搭載のEtherCAT Mデバイス

• 86Duino IDE(統合開発環境)搭載

• 抵抗膜式タッチスクリーン搭載9インチTFT LCD（800×480）

• HMI用HDMI出力付き高信頼性SLC eMMCストレージ

• 産業用動作温度範囲： -20～+70℃
• 完全なEtherCATスタック、PDO/SDO、CiA-402（PP/CSP/CSV）、診断機能およびログ機能搭載

• 電圧、温度、システムステータス監視機能搭載
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ロボットアーム概要｜OVR6048K1-V

• アームの仕様 (寸法、ペイロード、リーチ、制限) については、常にオリエンタルモーター社の公式資料
に従ってください。

• 製品ページとマニュアル（CAD、取り付け、安全に関する注意事項）を参照してください:
OVR 6軸多関節ロボット
https://www.orientalmotor.com.tw/tw-zh/products/robots-controllers/ovr-6-axis-articulated-robot

• 統合前に以下の項目をご確認ください:
• ペイロード / リーチ

• 関節制限 (J1–J6, 機械的及びソフトウエア制限)
• 原点/ゼロ定義

• ギア比 & 単位スケーリング(角度 パルス、速度・加速度単位)
• ツール・エンド・インターフェース(フランジ仕様、有効I/O/配線)
• 安全セクション (非常停止、立入禁止ゾーン、配線ルーティング)

* 注: この資料はQEC統合ワークフローを示すものであり、公式仕様ではありません。
必ずOEMマニュアルを参照してください。
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• AZ-miniドライバの仕様、配線、機能、安全性については、必ずオリエンタルモーター社の公式マ
ニュアル（AZ-miniドライバ）に従ってください。
https://www.orientalmotor.com.tw/tw-zh/products/alpha-step/az-mini-driver

• 本プロジェクトは、AZD-KRED (EtherCAT)を使います。

• 統合前に以下の点を確認してください：

• モデルとインタフェース (AZ-mini AZD-KRED EtherCAT)
• 定格電力および接地/シールド

• モーター/ブレーキの互換性とコネクタ

• ABZO絶対エンコーダのゼロ点設定およびバックアップ方法

• 単位と分解能 (電子ギア、パルス/回転、速度/加速度の単位とリミット)
• 原点復帰パラメータ (方式、速度、オフセット、位置決め完了条件)
• 環境と取付け (温度/振動、ケーブル長、発熱)

*注: このデッキに推奨されるドライバ： AZD-KRED (EtherCAT)

ドライバ概要｜AZD-KRED

1
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• 目的： 座標系、軌道生成、およびAPIにおける参照基準として、全関節の標準的な基準姿勢（ゼロ姿勢）
を確立します。

• 参照情報： メーカー仕様書によると、本モデルにはゼロ姿勢を機械的に設定するための位置決めピン
穴（φ4h7）が5箇所設けられています（ハイライトされた位置を参照）。

• いつ: 初めて使用する前に、およびメンテナンスやドライ

バの交換後に実行します。

• 手順（推奨）

1. 手動（またはティーチ）モードに切り替え、低速で目標姿勢に
近づけてください。

2. リンク機構の整合性を確認するため、5箇所の位置決めピン

穴にピンを挿入してください。

3. ±0.1°の許容範囲を許可します（設定可能）。

4. 安全（重要）： 停止中または動作中は、ドライバのFREE信

号を入力しないでください。モータ電流と保持力が遮断さ

れるため、ロボットが重力の影響で姿勢を崩し、落下する

可能性があります

OVR6048K1 – 基準となる姿勢

* 注意: 正確な位置/制限については、OEM マニュアルに従ってください。

初期姿勢

1

1



ゼロ姿勢

• 基準座標の原点は、ジョイントM1の中心における (0,0,0) に設定さ
れます。

• J1〜J6 を 0° に設定した標準姿勢がグローバル基準となります。

• 外的（エクストリンシック）回転順序：ワールド座標系
の X 軸 → Y 軸 → Z 軸の順に回転します。

• 合成行列：𝑅world=𝑅𝑧(𝑟𝑍)⋅𝑅𝑦(𝑟𝑌)⋅𝑅𝑥(𝑟𝑋)(𝑋→𝑌→𝑍の順に回転し

て構成されます）

ゼロ姿勢と座標系の取り決め

ゼロ姿勢・二次元図

* 注意: 正確な位置/制限については、OEM マニュアルに従ってください。

OVR6048K1
ゼロ姿勢正面図１

OVR6048K1
ゼロ姿勢正面図2
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各軸の分解能

• AZD-KRED (ドライバ)のデフォルト分解能は、10,000です。

• OVR6048K1-V軸モデルは次のとおりです（添付画像を参照）

• L with a 36- ratio reduce r: 360,000 s teps perM1: DGB130R36-
AZAK
revolution• er and aM2 and M3: 
AZM66M
100-ratio reducer: 1,00

H-CSG20-1
0,000 steps

00 with a 28
per revolut

-ratio reduc
ion

• 0 with a 50-r atio reducer : 500,000 st eps perM4: AZM26AK-CSF8-
5
revolution• M5 and M6: 
AZM24AK

-CSF8-50 
wi

th a 50-ratio reducer: 50 0,000
steps per revolution

軸 モーター/減速機 総比率 ステップ/回転 ステップ/角度 角度/ステップ

M1 DGB130R36-AZAKL 36 360,000 1,000.0 0.0010°

M2 AZM66MKH + CSG20-100 100¹ 1,000,000 2,777.78 0.00036°

M3 AZM66MKH + CSG20-100 100¹ 1,000,000 2,777.78 0.00036°

M4 AZM26AK + CSF8-50 50 500,000 1,388.89 0.00072°

M5 AZM24AK + CSF8-50 50 500,000 1,388.89 0.00072°

M6 AZM24AK + CSF8-50 50 500,000 1,388.89 0.00072°

13
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OVR6048K1版

2. 軌道表示ツール



軌道表示ツール紹介 - 1
何か?

• 軽量な3Dシミュレータで、OVR6048K1のリンク長、ゼロ姿勢、軸定義をプリセットします。

• FK（順運動学）／IK（逆運動学）に対応し、姿勢と可達性をリアルタイムに可視化します。

なぜ、使うか

• 実機ロボットを動作させる前に、ポーズ、経路、特異点を検証します。

• ウェイポイントとタイミングを生成し、それらをQECプログラム／HMIへ渡します。

軌道表示ビューア
15



軌道表示ツール紹介 - 2
特徴

• モード： IK / FK 切り替え、オプションで即時再計算のための OnValueChange を更新します。

• ポーズ I/O： J1～J6 または TCP (X、Y、Z、rX、rY、rZ) を編集し、どちらかの方法で解決します。

• キーフレーム： 次のフレームまたは全フレーム再生でステップで実行します。

• パスのインポート： testpath.txt を読み込み、フルモーションのタイムラインをシミュレートします。

規約

• 外部回転順序：X → Y → Z（ワールド座標系に基づく）

• ゼロ姿勢はOVR6048K1基準に合わせて調整済みです。単位：位置はmまたはmm、角度は度（deg）。

クイック操作

• マウス操作： 左ドラッグで回転、中央ドラッグでパン（移動）、ホイールでズーム。

• アクション： FKソルブ / IKソルブ、リセット。
16



軌道表示ツール UI機能

• チェック時 :ドラッグ中にライブ更新されます
• 未チェック時:値を編集し「FK/IK Solve」ボタンを押します

モードの切り替え（現在は非アクティブ）

全てリセット

FK Single-step solve ボタン

スライダーをドラッグするか、数値
を入力して変更します

IK Single-step solve ボタン

表示コントロール
• マウスホイールボタン : 回転
• マウス右ボタン: パン(PAN)

Z (Up)

X (Right)

IK computation message; 0 = error

Y (Front/Forward)

WCP wrist

End-effector

Tool

パス全体を順番にシミュレートします

検査のために次のウェイポイントまで進みます

Open Path (Fileメニュー) ＊備考AA

これを使ってIKソリューションがどれだけ
変動するかを観測します ＊備考B B備考B

軌道表示ツール 17

備考
A. パスファイル形式：1行につき1つのウェイポイント：{ms, X, Y, Z, rX, rY, rZ}。テキス
トファイルを読み込み、 All Frames / Next Frame 」でテストしてください。ファイル形
式または値が無効な場合は、エラーダイアログが表示されます。

B. モーションパスの終点ウェイポイントを定義する際は、まずUIを使って関節角度の
ジャンプを確認してください。現在のIKでは関節の制限が適用されないため、±180°
付近の反転は3Dでは分かりにくい場合があります。右上のスライダーをチェックして、
関節が制限に近づいていないか確認してください。



軌道表示ツールの起動 - 1
ステップ1 — IDEフォルダを開く

• 86Duino IDE ディレクトリ (例: …¥86Duino_Coding_501_Preview_20251001_OVR6048K1) に移動します。

軌道表示ツールのファイルパス
18



軌道表示ツールの起動 - 2
ステップ2 —ツールに移動する

• 開く: tool →KinematicsViewer

軌道表示ツールのファイルパス 2

軌道表示ツールのファイルパス 3
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軌道表示ツールの起動 - 3
ステップ3 —表示ツールを実行する

• KinematicsViewer.exe.をダブルクリックします。

実行ファイルとともにいくつかのサンプルの .txt ファイルが表示されます。

軌道表示ツールのファイルパス 4

軌道表示ツール2

20



19

軌道表示ツールの起動 - 4
ステップ4 —モーションパスを読み込む

• 表示ツールにて: File → Import/Open Path… → testPath.txtを選択します。
(または、all.txt、all2.txt、step1_…txt などの他のサンプルファイルを選択します。)

• 軌道をシミュレートするには、Play All Frames / Next Frame を使います。

軌道表示ツール– ファイルオープン 1

軌道表示ツール–  ファイルオープン 2

軌道表示ツール関数
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軌道表示ツールの起動 - 5
ステップ5 —値を変更する

ビューアでは、「 Joint position 」または「 EFF, Tool Poseture 」エリアのバーまたは入力値をドラッグする
ことで、ビューウィンドウ上でロボットの動作をシミュレートできます。シミュレーション終了後は、「 EFF,
Tool Poseture 」エリアの値と対応するAPI関数への入力値を使用して、軌道表示ツールと同じ位置にアー
ムを制御できます。

運動制御ビューラ関数
ビューワウインドウ

Kinematics Example Code

ArduBlock： ロボットアームブロックの移動

22



避けるべき経路計画- 1
Y (前方)

X (右方向)

1 2 3 4 ベースシータ1は+/-180に近い

運動制御が経路を回避する-1

*注意：一部の動作経路では、ベースが回転限
界付近まで動く可能性があります。X印が付け
られた象限をまたぐ経路は避け、元の経路の
象限に戻す必要があります。
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避けるべき経路計画- 2

X
(右)

1 2 3 4 ベースシータ1は+/-180に近い

X
(右)

Y (前方) Y (前方)

運動制御が経路を回避する - 2

24

*注意：一部の動作経路では、ベースが回転限
界付近まで動く可能性があります。X印が付け
られた象限をまたぐ経路は避け、元の経路の
象限に戻す必要があります。



避けるべき経路計画- 3

手首の回転を確認してください。X=0平面では、ジョイント5は-90度に近い位置で問題ありません。

ただし、X が X=0 平面からわずかにずれている場合 (たとえば、X=-0.01)、J5を +/-90 度に近づけると、
Theta 4はジッタを減し、変動を最小限に抑えるためTheta 4/6は端に向かって移動します。

この時点で、終了位置Xが象限をまたいで移動すると（例えば、X=-0.01 0.01）、Theta 4とTheta 6は+/-
180度移動します。したがって、J5が+/-90度に近い場合は、同様の動きをしないように注意してください。

(次ページに続く)

運動制御が経路を回避する- 3 運動制御が経路を回避する- 4
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1

避けるべき経路計画- 4
2 3

4 5 6

運動制御が経路を回避する- 5

26
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3. 使い方？
APIの紹介、コーディング方法、グラフィクツール



86Duino IDE 501

ソフトウェアの概要とダウンロード
オリエンタルモーター社ロボットアーム（6軸）向けに、86Duino IDEの特別バージョンをリリースしました。
OVR6048K1-V特有のモーション、運動制御、ビューアをサポートしています。

ここから86duino IDEはダウンロードできます：https://ftp.dmp.com.tw/share/Ch_rBIbF
• パスワード：icop
• ファイル名： 86Duino_Coding_501_Preview_20251001_OVR6048K1.zip

86Duino IDE 501の新しい主リリースは、これまで以上に高速で強力になりま
した！ 今回のバージョンでは、より幅広いサードパーティ製 EtherCAT Subデ
バイスに対応し、さらに EthercatDeviceクラスが追加されました。中でも、
CiA402規格に準拠した任意のEtherCATサーボドライブを制御できる汎用の
CiA 402 EtherCAT Subデバイスクラスが導入されています。

• EtherCATライブラリAPIユーザーマニュアル：
https://www.qec.tw/ethercat/api/ethercat-library-api-user-manual/
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開発環境のセットアップ- 1
環境を設定するには、以下の手順に従います:

1. QEC-M-090TをUSB Type-C - USBケーブルでPCに接続します（86Duino IDEがインストールされたPC）。

2. QECの電源を入れます。

3. PC で「 Device Manager 」（Win+X を押した後のメニューで選択）ー＞「 Ports (COM & LPT)」を開きます。
「 Prolific PL2303GC USB Serial COM Port (COMx)」が検出されているはずです。検出されない場合は、必
要なドライバをインストールする必要があります。
（Windows PL2303ドライバは、 ここからダウンロードできます。）

QEC-M オープンフレームボード側面図
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開発環境のセットアップ- 2
4. 86Duino IDEを開きます。

5. 適切なボードを選択してください： IDEのメニューで、「 Tools 」>「 Board 」>「 QEC-M090T 」（または
使用しているQEC Mデバイスモデル）を選択します。

6. ポートの選択： IDEメニューで「 Tools 」>「 Port 」を選択し、QEC Mデバイスに接続するUSB​​ポート（こ
の場合はCOM8（QEC））を選択します。

Tool - Board Tool - Port
30



例： 運動制御テスト - 1
ステップ１ーサンプルを開く

• 「 Tools▸ Board 」で「 QEC-M090T 」を選択し、適切なポー
トを選択すると、サンプルセットが表示されます。

• 「 File▸ Examples▸ Orientalmotor 6-Axis Arm
▸kinematics_test 」を開きます。

86Duinoの例
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例：運動制御テスト - 2
ステップ2 - コードを表示してHMIを開く

• kinematics_test を開くとスケッチが読み込まれます
（右図）。下記の3つのライブラリを使用します：

• myhmi.h — HMIヘルパ

• OVR6048K1_V.h — ロボット・モーション・ヘルパ

• Ethercat.h — EtherCATプロトコル

• この例では、次の設定を使用します：

• EtherCATサイクルタイム：250マイクロ秒(μs)。

• EtherCATモード： ECAT_SYNC。

• 分散クロック(DC): Enable (250 μs)。

• CiA-402モード： CSP (周期同期位置)。

Kinematics_test.ino

• 86HMIアイコン（右上）をクリックして、
HMIエディタを起動します。

Kinematics_test.ino EtherCATに関するコード
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例：運動制御テスト - 3
ステップ３ — ８６ＨＭＩレイアウトとコード生成

• サンプルHMIには、power_on、power_off、run、move1～
move4（右図参照）の7つのボタンが含まれています。次のセ

クションでは、それぞれのボタンをコードにマッピングしま
す。

• 「Code 」ボタン (右上) をクリックすると、イベントスタブと
includeステートメントが生成され、メインスケッチに貼り付け
られます。

• 生成後、myhmi.h と myhmi.cpp が表示されます。これらは
LVGL86ライブラリのヘルパと実行プログラムを表します。

* 追加情報: 86HMIでは、すべてのオブジェクトに一意のIDがあり、

命名規則は右の図に示すように、クラスシリアル番号を含む
ページ番号です。

Kinematics_test HMIの例

86HMI生成ファイル

86HMI ID命名規則
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例：運動制御テスト - 4

ステップ4 — ビルドとアップロード

コードを記述したら、ツールバーの をクリックしてコ
ンパイルし、コンパイルが完了してエラーがないことを確
認後、 をクリックしてアップロードします。

アップロードが完了すると、下のウィンドウに
「Done uploading 」と表示されます。

86Duinoアップロードと検証アイコン

86Duinoアップロード完了 34



例：運動制御テスト - 5
結果

プログラムをQEC-M-090Tに正常にアップ
ロードすると、QEC-M-090TにHMIが表示さ
れ、確認できます。

kinematics_test の例を表示するQEC-M-090T

各ボタンの機能

 POWER ON (p1b1)

power_on();

 POWER OFF (p1b2)

power_off();

 RUN (p1b3)

run_demo3(5.02);

 1 (p1b4)

Set_Des_Position(0.0, 24.0, 26.8, 0.0, -45.0, 0.0);
prepare_move();

 2 (p1b5)

Set_Des_Position(0.0, 24.0, 26.8, 0.0, -20.0, 0.0);
prepare_move();

 3 (p1b6)

Set_Des_Position(0.0, 24.0, 26.8, 0.0, 20.0, 0.0);
prepare_move();

 4 (p1b7)

Set_Des_Position(0.0, 24.0, 26.8, 0.0, 45.0, 0.0);
prepare_move();

12 3

4 5 6 7

*次のページ：各機能の機能と動作の実行方法について説明します。
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利用の流れとAPI概要 - 1

利用の流れ

• セットアップ →

• 電源投入 → ▸

• 移動 →

• ループ → HMIイベント

begin() ▸ attach() ▸ setDc() ▸ setCiA402Mode() ▸ attachRTCyclicCallback() ▸ start()

enable() poweron_init() ▸ home()

API概要

OVR6048K1_V.h

API どこで 目的 典型的な使い方

OVR6048K1_V_begin() セットアップ 内部バッファ/パラメータの初期化 EtherCAT の起動前に 1 回呼び出します

OVR6048K1_V_loop() ループ 内部管理/状態 ループの繰り返しごとに呼び出します

OVR6048K1_V_callback(long* pos) 周期コールバック 次のターゲットの作成（相対/絶対） true が返された場合は、ターゲットを PDO に書き込みます

Set_Des_Position(x,y,z,rx,ry,rz) 動作前のループ/HMI 目標姿勢を設定す（線形や円弧軌道を実行する前に） その後、prepare_move() または arc API を呼び出します

prepare_move() ループ/HMI 目標姿勢への直線移動の実行 周期コールバックを介して実行します

prepare_arc_move() ループ/HMI 円弧移動の実行（平面/中心/方向を使用） 最初に平面/中心/方向を設定します

set_arc_plane(XY/XZ/YZ) ループ/HMI 円弧平面の選択 円弧の前提条件

set_arc_dir(ARC_CW/ARC_CCW) ループ/HMI 円弧方向 デフォルトで問題ない場合は省略可能です

Set_center_offset(cx,cy,cz) ループ/HMI 円弧中心（相対） prepare_arc_move() の前に使用します

poweron_init() 電源投入 有効後に内部パラメータの初期化 有効時に 1 回呼び出します

emergency_stop() エラー/安全性 即時停止：再開するには再初期化が必要 停止時に使用します

Set_Des_Position()▸prepare_move()/ prepare_arc_move()(コールバック経由でストリームをターゲットとする)
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利用の流れとAPI概要 - 2

API概要

Ethercat.h

Ethercat.h > CiA402

API どこで 目的 典型的な使い方

master.begin() セットアップ Subデバイスをスキャンし、Ｐｒｅ－Ｏｐに入る 最初のEtherCAT呼び出し

motor[i].attach(i, master) セットアップ SubデバイスiをMデバイスに関連付ける 各軸について

motor[i].setDc(cycle_ns) セットアップ DC を有効にし、周期を設定する 例：250,000 ns (250 µs) または 1,000,000 ns

master.attachRTCyclicコールバック(cb) セットアップ リアルタイム周期コールバックを登録する PDOループ

master.start(cycle_ns, ECAT_SYNC) セットアップ SM/FMMU/DC を設定し、OP に入る 周期OPを開始

pdoWrite()/pdoRead() コールバック プロセスデータの書き込み/読み取り 通常はモーターAPIで抽象化されている

API どこで 目的 典型的な使い方

motor[i].setCiA402Mode(CIA402_CSP_MODE) セットアップ/ループ CSPモードを選択 始動前

motor[i].enable() 電源投入/ループ オペレーション有効モードに移行する OPおよび準備完了後

motor[i].getCiA402State() コールバック/ループ ドライブ状態を照会 モーション実行前にチェックするロジック

motor[i].setTargetPosition(pulse) コールバック/ループ ターゲット（PDO）に書き込み OVRのコールバック/ゲート条件から

motor[i].getPositionActualValue() コールバック/ループ 実際の位置を読み取る 原点復帰／モニタリング
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APIで直接ビューア値を使用する
ユーザーは、軌道表示ツールから同じ姿勢の値を取得し、コード（またはArduBlock）に適用してアー

ムを駆動できます。ビューアでは、スライダをドラッグするか、数値を入力して姿勢をシミュレート
し、その値をAPIにコピーします。

ETF下のフィールド、Tool Posture — (X, Y, Z, rX, rY, rZ) —は、1:1で、次のようにマップされます：

ステップ：

1. EFFにて, Tool Posture, X, Y, Z, rX, rY, rZを設定/確認。
2. それらを1:1で、Set_Des_Position(x, y, z, rX, rY, rZ);にコピー。
3. prepare_move();を呼び出し、実行。

その後、軌道表示ツールと同じ位置に腕を制御できます。

軌道表示ツール : EFF, Tool Poseture
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4. はじめましょう - 1
ローコードの例 : 86HMI + ArduBlock

39



86HMI + ArduBlock – 概要 1
86HMI — UIデザイナ(HMI)

• 概要: LVGL86ライブラリをベースにしたドラッグ・アンド・ドロップ式のスク
リーンエディタです。

• 作成するもの： ボタン、ラベルなど、固有のIDにバインドされたオブジェクト
（例：p1b1、p1b2）。

• 生成するもの： スケッチに貼り付けるC/C++ UIスタブ。イベントは自動生成
されるHMIイベントセクションで処理されます。

• 重要性： オペレータがパネルから直接モーション（電源のオン/オフ、プリセット
の移動、デモの実行）をトリガーできます。

ArduBlock — モーションロジック (ブロック)

• 概要： 86Duino IDEをベースにしたブロックベースのエディタです。

• 作成するもの： HMI、EtherCAT、モーション用のブロックを使用した高レベルロ
ジックです。

• 生成するもの： 指定されたAPI(例： power_on()、 Set_Des_Position()、
prepare_move()）を呼び出す86Duino コードです。

*注: ARM6クラスブロックはOVR6048K1-Vプロジェクト専用です

86HMI エディタ

ArduBlock
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OVR6048K1

86HMI + ArduBlock – 概要 2
なぜ両方？

• 86HMIは、操作インタフェースを設計します。

• ArduBlockは、これらのUIイベントをロボットの動作に関連付けます。

• これらの組み合わせは、ボタン→API呼び出し→EtherCATモーションと
いうローコードパスを実現します。

ArduBlock
86HMIエディタ
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例： ローコードによる運動制御 - 1
ステップ1 - 新しいプロジェクトを開いてHMIを設計する（86HMI）

環境設定については、例： 運動制御テストを参照してください。

① 86HMIエディタを開きます。

② QEC-M-090Tを選択します。

③ 「OK」ボタンをクリックすると、エディタパネルが表示されます。

1 2

3

86HMI エディタ

86Duino –  86HMIアイコン
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例： ローコードによる運動制御 - 2
ステップ2 - 3つのボタンを作成

最初のページに、「 Open 」、「 Go 」、「 Close 」の3つのボタンウィジェットを作成します。

① 左側のメニューで「 Button 」をダブルクリック、また描画エリアまでドラッグします。

② 3つのボタンを複製します。

③ 右側のPropertiesメニューでテキストを「 Open 」、「 Go 」、「 Close 」に変更します。

④ 各オブジェクトのIDを確認します。（例：p1b1、p1b2、p1b3）

1

2

3

4

86HMIエディタ

86HMI プロパティ
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例： ローコードによる運動制御 - 3
ステップ3 — 86HMIコード生成

「 Code 」（右上）をクリックしてUIコードを生成し、スケッチにコピーします。

86Duino –  86HMIファイル86HMIエディタ 44



例： ローコードによる運動制御 - 4
ステップ4 — ArduBlockを開く

右上のアイコンからArduBlockを開きます。

ArduBlock

86Duino –  ArduBlockアイコン
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例： ローコードによる運動制御 - 5
ステップ5 —セットアップにARM6初期化ブロックを配置する

まず、オリエンタルモーター社のドライバパラメータを初期化する必要があります。これらのパラメータは、
既に「ARM6初期化」というブロックにパッケージ化されており、「EtherCAT: Motion」クラスに含まれてい
ます。

これをプログラムの「セットアップ」領域に配置します。

ArduBlock –  ARM6初期化

ArduBlock –  EtherCAT : モーション
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例： ローコードによる運動制御 - 6
ステップ6 — HMIイベントブロックをループに配置する

ロボットアームとHMIを連携させたいので、HMIイベントをループに配置する必要があります。

ボタンイベント（例： クリック、押下）は、「 HMI : Control 」クラスにある「 HMI Event Section 」というHMIイ
ベントに関連付ける必要があります。

ArduBlock –  HMI Event section

ArduBlock –  HMI : Control
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例： ローコードによる運動制御 - 7
ステップ7 — HMIイベントにボタンイベントを追加する

「 HMI :Control 」クラスの「 HMI Event Section 」に、「 if Button is clicked 」ブロックというボタンイベントを
追加します。特定のボタンがクリックされた場合、HMIイベントは「true」を返します。

ボタンが3つ必要なので、クリックされたボタンのブロックを3つ複製し、IDをp1b1、p1b2、p1b3 に変更しま
す。

ArduBlock –  HMI : Control ArduBlock –  if Button is clicked
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ステップ8 —ボタンイベントにARM6の電源オン/移動/電源オフを設定する

OVR6048K1の機能は、「EtherCAT: Motion」クラス内の「ARM6 power on 」、「ARM6 move to 」、「ARM6
power off 」などのブロックに既にパッケージ化されています。

これらのOVR6048K1機能ブロックを、「if Button is clicked 」ブロックに以下のように設定します：

• p1b1を「ARM6 power on 」に、p1b2を「ARM6 move to 」に、p1b3を「ARM6 power off 」にします。

*注: 「 ARM6 move to 」ブロックのパラメータには、軌道表示ツールの位置値を使用してください。

例： ローコードによる運動制御 - 8

ArduBlock –  EtherCAT : Motion ArduBlock –  ARM6 move to
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ステップ9 —コード生成とアップロード

完了後、「 Code Generate & Upload 」ボタンをクリックしてコードを生成し、QEC-M-090Tにアップロードで
きます。

このブロックプログラミングでは、EtherCAT通信を確立し、AZ-miniドライバを設定し、HMIボタンを使
用してOVR6048K1ロボットアームを設定、制御します。

例： ローコードによる運動制御 - 9

ArduBlock –  86Duino –  HMIコード
ArduBlock –  86Duino
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例： ローコードによる運動制御 - 10
結果

プログラムをQEC-M-090Tに正常にアップロー
ドすると、QEC-M-090Tに表示されるHMIを確
認できます。

QEC-M-090T とローコードの例

各ボタンの機能

① Open (p1b1)

② Go (p1b2)

③ Close (p1b3)
1 2 3
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ArduBlockでビューアの値を直接使用する
ユーザーは、軌道表示ツールと同じ姿勢を取得し、コード（またはArduBlock）に適用してアームを駆動

できます。ビューアでは、スライダをドラッグするか、数値を入力して姿勢をシミュレートし、その値を
APIにコピーします。

EFF の下のフィールド 、 Tool Posture — (X, Y, Z, rX, rY, rZ) —は、
1:1 で、次のようにマッピングされます：

ステップ：

1. EFF、Tool Postureで、X、Y、Z、rX、rY、rZ を設定/確認します。

２．それ多をARM6 move to(X, Y, Z, RX, RY, RZ)ブロックに1:1でコピーします。

その結果、軌道表示ツールと同じ位置にアームを制御できます。

軌道表示ツール: EFF、 Tool Poseture

ArduBlock ロボットアーム移動ブロック
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5. はじめましょう - 2
RobotArm6Rの例
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例： RobotArm6R– 概要
QEC-M-090T と AZD-KRED × OVR6048K1-V を組み合わせで、ECAT_SYNC＋DCを用いることで、球
面上でのエンドエフェクタの滑らかな軌道を、計画からシミュレーション、ワンタッチHMI操作まで一貫
して実行します。

RobotArm6R HMIの例

RobotArm6R 86Duinoの例

RobotArm6R 起動表示ツール

RobotArm6R基準姿勢 RobotArm6Rの例
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例： RobotArm6R - 1
ステップ１：例を開く

• 「 Tools▸ Board 」で「QEC-M090T」を選択し、適切なポー
トを選択すると、サンプルセットが表示されます。

• “File ▸ Examples ▸ Orientalmotor 6-Axis Arm 
▸RobotArm6R”を開きます。

86Duinoの例
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例： RobotArm6R - 2
ステップ2 - コードを表示してHMIを開く

• RobotArm6Rを開くとスケッチが読み込まれます（右）。
3つのライブラリを使用します：

• myhmi.h — HMIヘルパ

• OVR6048K1_V.h — ロボット・モーション・ヘルパ

• Ethercat.h — EtherCATプロトコル

• RTCZero.h — RTCタイマライブラリ

• この例では、以下の設定を使用します：
• EtherCATサイクルタイム：250 マイクロ秒 (μs)。

• EtherCATモード： ECAT_SYNC。

• 分散クロック(DC): Enable (250 μs)。

• CiA-402モード： CSP (周期同期位置）。

RobotArm6R.ino

• 86HMIアイコン（右上）をクリックして
HMIエディタを起動します：

EtherCATのRobotArm6R.ino コード
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① Power（電源）
すべての軸ドライバを有効または無効にします (CiA402 の有効/無効に切り替
えます)。

② 作業空間ナビゲータ
ロボットアームの作業空間の値を、x、y、z（mm）、rx、ry、rz（°）で表示します。こ
の領域は LineDemo ページ内で操作可能であり、ユーザーは作業空間内で

アームを移動できます。ただし、事前にホーミングを行う必要があり、デモ実行
中は同時に操作することはできません。

③ モーターモニタ

ロボットアームの位置（モータードライバから読み取った値）を表示します。また、
現在の位置を示すバーも表示します。

④ コントロールパネル (Home)
LineDemo では、この領域にホーム ボタンがあり、アーム (すべての軸) を原
点位置に移動します。

⑤ コントロールパネル (Run)
ArcDemo では、Run ボタンと2つのラジオオプション（60mm と 10mm）があ
る領域です。移動オプションを選択した後に、 Run ボタンをクリックすると、
ロボットアームが選択した寸法の球面上を動き始めます。Run ボタンを再度

クリックしない限り、動作は継続されます。正しい寸法の球体をクリックする
必要があることに注意してください。これはホーミング後に行ってください。

ステップ３ – 86HMIレイアウト

• HMIは、LineDemo と ArcDemoの２ページ
があります。

例： RobotArm6R- 3

LineDemoページ

2

3

4

1

ArcDemo ページ

5

各HMIオブジェクトの機能
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RobotArm6R HMIの例

例： RobotArm6R- 4
ステップ4 — 86HMIコード生成

• 「Code 」ボタン (右上) をクリックすると、イベントスタブと
includeステートメントが生成され、メインスケッチに貼り付
けられます。

• 生成後、myhmi.h と myhmi.cpp が表示されます。これらは
LVGL86 ライブラリのヘルパと実行プログラムを表します。

86HMI ID命名規則

86HMI生成ファイル

* 追加情報: 86HMIでは、すべてのオブジェクトに一意の IDが

あり、命名規則は右の図に示すように、クラスシリアル番号を
含むページ番号です。
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例： RobotArm6R - 5
ステップ5 - ビルドとアップロード

コードを記述したら、ツールバーの をクリックしてコンパ
イルします。コンパイルが完了し、エラーがないことを確認し
たら、 をクリックしてアップロードします。

アップロードが完了すると、下のウィンドウに「 Done
uploading 」と表示されます。

86Duino アップロード及び検証アイコン

86Duinoアップロード完了 59



例： RobotArm6R の説明
RobotArm6Rの例では、指定した半径の球体の周りを動きます。デモには、半径60mmと100mmの球体
の2種類があります

ユーザーは、起動表示ツールでパスの値を確認できます。例は all.txtおよび all2.txtと呼ばれます。

robotArm6R 球面移動デモのパス軌道表示ツールでのrobotArm6Rの移動 -2軌道表示ツールでのrobotArm6R の移動 -1

60



例： RobotArm6R – ビデオ

結果

(ビデオ： https://youtu.be/9-X3WKAfU1o?si=HUMSyUU-MeYdyDMh )

61

https://youtu.be/9-X3WKAfU1o?si=HUMSyUU-MeYdyDMh
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https://youtu.be/9-X3WKAfU1o?si=HUMSyUU-MeYdyDMh


Thank you!!
さらに詳しい情報をご希望の場合は、お気軽にお問い合わせください。

QEC Website ICOP Website Orientalmotor Website
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